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1
 SketchUp Design Modeling ARCT 301 แนวคดในการออกแบบขนรปโมเดลของโปรแกรม Sketch Up
 ส าหรบโปแกรม Sketch Up นนไดรบความนยมเปนอยางสงอนเนองมากจากแนวคดของโปรแกรมทเนนหนก
 ไปทความงายในการขนรป เพอชวยใหนกออกแบบสามารถถายทอดแนวความคดในการออกแบบใหออกมาไดอยางรวดเรวทสด และมขนตอนนอยทสด ประกอบกบความยดหยนในการปรบแตงโดยงายในลกษณะของการท าแบบรางในกระบวนการออกแบบโดยทวไป แนวคดของการขนรปโมเดลใน sketch up จะแตกตางจากโมเดลในโปรแกรมสามมตอนๆ ซงมสวนท าใหโมเดลทขนรปใน sketch up นน มความงายและปรบเปลยนไดงาย กลาวคอลกษณะของโมเดลใน sketch up จะมลกษณะแบบวตถแบบแผน แทนทจะเปน ลกษณะแบบวตถทบตน
 ซงมคณสมบตพเศษในการแกไขไดงายโดยทไมมการเพมพนผวเพมเตมแตอยางใด อาจจะกลาวไดวาลกษณะของโครงสรางในการปนโมเดลของโปรแกรม sketch up นนเปนการสรางหรอขนรปทรงจากเสน (Line) เปนหลกหรอในทนเรยกวา เสนขอบ (Edge) และมการตรวจสอบวาเสนขอบดงกลาวมลกษณะเปนเสนทมการปดใหเกดแผนระนาบหรอไม หากมการปดของเสนขอบจนเกดแผนระนาบกจะมการสรางแผนพนผว (Face) ขนมาโดยอตโนมต ส าหรบแผนระนาบเดมทมอยหากมการขดเสนพาดลงไปแลวแบงพนทออกจากกนกจะมการแยกระนาบนนออกทนท และหากมการลบเสนนนทง ระนาบดงกลาวกจะเชอมกนดงเดม ซงเปนการสะดวกตอการแกไขอยางมาก
 ซงการท างานปนโมเดลใน sketch up จะเปนการท างานบนระบบ 3 มต ไปพรอมๆกนซงมแนวแกนทใชควบคมในพนทการท างานแยกออกเปน 3 แนวแกน
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 สแดง จะแทนแนวแกน X, สเขยวจะแทนแนวแกน Y และ สน าเงนจะแทนแนวแกน Z ซงสแนวของแนวแกนทงสามนจะมผลอยางมากในการก าหนดระนาบของโมเดลทปนขนมา นอกจากนการปนโมเดลในโปรแกรม sketch up ยงมความงายดวยความชวยเหลอของเครองมอทมความฉลาดในการจบไปยง จดตางๆ หรอระนาบทตองการไดซงเรยกวา “Inference Engine” โดยทเครองมอนจะมการท างานเมอมการใชค าสงสรางหรอแกไขวตถตางๆ
 Warm up Exercise
 1. ทดลองใชเครองมอ (Line Tool) ในการเขยนระนาบพน
 2. เขยนเสนขอบดานขางกลองโดยใชแนวแกน Y เขาชวย
 3. ใชเครองมอ (Eraser Tool) ในการลบเสนทเกนหรอไมตองการ และ (Orbit Tool) ในการหมนมมมองของโมเดลทท างาน ชวยในการปนโมเดลใหเกดเปนรปทรงทส าเรจ
 แกน X
 แกน Y
 แกน Z
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 การท างานบนพนทสภาพแวดลอมของโปรแกรม Sketch Up
 User in interface ของ google sketch up ไดถกออกแบบมาเพอใหใชงานไดอยางเรยบงายและมหนาตา
 เหมอนกบแอปพลเคชนทวไป ทประกอบไปดวย ไตเตลบาร เมน ทลบาร พนทวาดภาพ และกลองควบคมตางๆ
 หนาตางการท างาน (Model Window) ของโปรแกรม Sketch Up จะมลกษณะเปนแบบการแสดงผลแบบเดยวหากตองการเปลยนมมมองกตองท าการหมนและปรบแตงจากเครองมอก าหนดมมมองตางๆ
 การใชเมาสควบคมการแสดงผล
 การใชเมาสชวยในการควบคมการแสดงผลบนหนาจอการท างานของโปรแกรม Sketch Up โดยมากจะใชเมาส
 แบบ 3 ปม เปนเครองมอส าคญ โดยใชการควบคมดงน
 การหมนภาพ (Orbit) ใชเมาสปมกลาง กดคางแลวเลอนเมาส
 การยอขยายภาพ (Zoom) หมนปมกลางของเมาส
 การกวาดภาพไปมา (Pan) ใช Shift+ เมาสปมกลาง กดคางแลวเลอนไปมา นอกจากนการก าหนดมมองตางๆยงสามารถเลอกการแสดงไดจาก View Toolbar
 เปดเครองมอไดจาก View > Toolbar > Views การปรบสภาพแวดลอมของโปรแกรมใหสอดคลองกบการท างาน
 โดยปกตแลวเมอเราท างานออกแบบเชงสถาปตยกรรมการจดการกบหนวยการท างานจะมผลอยางมากตอสดสวน
 และการออกแบบ ซงสามารถทจะปรบแกไขการก าหนดหนวยตงแตเรมท างานน
 เรยกเมน Window >> Model Info แลวเลอกรายการ Units ตงคาหนวยใหเหมาะสม
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 1. ก าหนดรปแบบของหนวยทใชในการท างาน
 2. ก าหนดความละเอยดของทศนยมของหนวยทท างาน
 3. ก าหนดการควบคมระยะการกระโดดของเมาส
 4. ก าหนดความละเอยดของทศนยมหนวยขององศา 5. ก าหนดการควบคมระยะของการปรบมม
 การปรบต าแหนงทตงของชนงาน
 ส าหรบการท างานบนโปรแกรม Sketch Up นนมคณสมบตทเดนประการหนงคอการก าหนดต าแหนงทตงหรอสถานทใหกบชนงานนนได ซงจะใชอางองในการก าหนดทศทางของแสงและเงาทจะแสดงผลเมอโมเดลอาคารมความสมบรณแลว
 1
 2
 3
 4
 5
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 Tool Bar
 ทลบารเปนแหลงเครองมอทส าคญในการวาดภาพตางๆใน Sketch Up เครองมอเหลานประกอบไปดวย Select Tool, Line Tool, Rectangle Tool, Circle Tool, Arc Tool , Make Component, Eraser Tool, Tape Measure Tool, Paint Bucket Tool, Push/Pull Tool, Move Tool, Rotate Tool, Offset Tool, Orbit Tool, Pan Tool, Zoom Tool, Zoom Extents Tool, Get Current View button, Toggle Terrain button, Place Model button, Get Models button, และ Share Models button เปนตน
 เครองมอการวาดภาพ (Drawing Tools) มดงน
 Select Tool ใชเพอเลอกวตถหรอกลมวตถทตองการโดยการคลกทไอคอนรป หรอท าไดโดยการกด space bar
 - การเลอกวตถเดยว ท าไดโดยการคลกท จะท าให cursor เปลยนเปนรปลกศรและคลกทวตถทตองการเพอเลอกวตถนน
 - การเลอกวตถหลายๆอน ท าไดโดยการ drag ลกศรคลมวตถทตองการดงรป
 การ Drag เลอกวตถหลายอน
 Paint Bucket Tool
 Paint Bucket Tool มหนาทก าหนดสและชนดของวสดใหกบโมเดลโดยการคลกทไอคอนรป หรอกด B
 การใสสหรอพนผวใหโมเดลท าไดดงน
 1. เลอก Paint Bucket Tool แลว Material Browser จะปรากฏขน
 2. เลอกชนดของวสดทตองการจาก Material Browser
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 3. คลกทหนาวตถทตองการก าหนด
 Rectangle Tool Rectangle Tool เปนเครองมอทใชวาดรปสเหลยมทสามารถยดหยนไดตามทผใชเลอกการวาดรปสเหลยมท าไดดงน
 1. คลกทไอคอน หรอกดปม R จะท าให cursor เปลยนเปนรปดนสอและรปสเหลยม
 2. คลกเพอก าหนดมมแรกของรปสเหลยม
 3. เลอนเมาสไปยงต าแหนงใหเกดรปสเหลยม
 4. คลกเมาสอกครงเพอก าหนดจดสดทายของรปสเหลยม
 Line Tool Line Tool เปนเครองมอในการวาดเสนตรงทสามารถปรบเลยนทศทางและสรางเสนตรงทบกนได
 วธการวาดเสนตรงท าไดดงน
 1. คลกทไอคอน จะท าให cursor เปลยนเปนรปดนสอ
 2. คลกเพอสรางจดเรมตนของเสนตรง 3. เลอน cursor ไปยงต าแหนงของจดสนสดของเสนตรง 4. คลกเพอวาดเสนตรง ซงจดสนสดนจะสามารถเปนจดเรมตนของเสนตรงเสนตอไปได

Page 7
                        

7
 Circle Tool Circle Tool เปนเครองมอในการวาดรปวงกลมทสามารถยด ขยายขนาดได การวาดวงกลมท าไดดงน
 1. เลอกไอคอน จะท าให cursor เปลยนเปนรปวงกลม
 2. คลกเพอวางจดศนยกลางของวงกลม
 3. เลอนเมาสออกจากจดศนยกลางเพอก าหนดรศมของวงกลม
 4. คลกเพอสรางวงกลม
 Polygon Tool Polygon Tool เปนเครองมอในการวาดโพลกอน (รปทมมากกวาสเหลยม) การวาดโพลกอนสามารถวาดทบกบรปทรงเดมทมอยหรอจะสรางใหมกได การวาดโพลกอนท าไดดงน
 1. เลอกไอคอน โพลกอนจะท าให cursor เปลยนเปนรปโพลกอน
 2. คลกทจดศนยกลางของโพลกอนทตองการ
 3. เลอนเมาสออกจากจดศนยกลางเพอก าหนดรศมของโพลกอน
 4. คลกอกครงเพอวาดรปโพลกอน
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 Pull/Push Tool Pull/Push Tool เปนเครองมอส าหรบดงและดนสวนหนาตางๆของวตถหรอสามารถสรางวตถสามมตจากรปรางทแบนราบได สามารถเรยกใชไดโดยเลอกไอคอน Pull/Push หรอกด P
 การสรางวตถสามมตจากรปแบนสามารถท าไดดงน
 1. เลอก Pull/Push Tool จะท าให cursor เปลยนเปนรปทรงสามมต
 2. คลกทสวนหนาของพนผวทตองการ
 3. เลอนเมาสขนหรอลงตามตองการ
 4. คลกเพอเสรจสนการสรางวตถสามมต
 Follow Me Tool Follow me Tool เปนเครองมอทใชส าหรบดงหนาตดของรปทรงทตองการไปตามแนวเสนขอบหรอเสนทรางขนมาเปนแนวในการวงของหนาตดเพอใหเกดรปทรง สามารถเรยกใชไดโดยเลอกไอคอน Follow me
 การสรางรปทรงจากหนาตดและเสนขอบสามารถท าไดดงน
 1. เลอก Follow me Tool เมาสจะเปลยนเปนรปเครองมอ Follow Me
 2. คลกเลอกสวนหนาตดพนผวทตองการ
 3. เลอนเมาสไปตามเสนขอบทก าหนดไวจนครบแนวตามทตองการ
 4. คลกเมาสเพอเสรจสนการสรางวตถตามแนวเสนทางทเลอก

Page 10
                        

10
 Scale Tool Scale Tool เปนเครองมอทใชในการยอขยายขนาดของวตถโดยสามารถเลอกแนวแกนในการปรบขนาดไดตามความตองการนอกจากนยงสามารถเลอกรปแบบของการปรบเปลยนขนาดจากกงกลางหรอจดขวตรงขามไดอกดวย สามารถเรยกใชไดโดยเลอกค าสง Scale Tool หรอกดปม S
 การปรบเปลยนขนาดวตถท าไดดงน
 1. เลอก Scale Tool เมาสจะเปลยนเปนรปเครองมอ Scale
 2. คลกไปยงพนผวหรอวตถทตองการใหมการปรบเปลยนขนาด
 3. เลอกลกษณะของการปรบขนาดในแนวแกนทตองการและจดอางองทตองการโดยคลกคางทจดการปรบเปลยนทตองการแลวเลอนเมาสเพอปรบขนาด สามารก าหนดขนาดของการปรบเปลยนไดโดยพมพตวเลขเชนกน
 4. เมอไดขนาดทตองการแลวจงปลอยเมาสจงเปนการเสรจสนการปรบขนาดนน
 Offset Tool Offset Tool เปนเครองมอทใชในการสรางแนวเสนคขนาดใหเกดขนมาโดยแนวเสนตนแบบทอางองเสนคขนานทเกดขนนนตองเปนเสนทมการปดลอมสนทพอด เรยกใชค าสงไดโดยเลอกค าสง Offset Tool หรอกดปม F
 การสรางเสนคขนานของพนผวหรอหนาตดใดๆ ท าไดดงน
 1. เลอก Offset Tool เมาสจะเปลยนเปนรปเครองมอ Offset
 2. คลกไปยงสวนของพนผวทเสนขอบนนเปนตวก าหนด
 3. เลอนเมาสจะพบเสนคขนานตามออกมาจากเสนขอบอางองดงกลาว
 4. เมอไดระยะของเสนคขนานทตองการ คลกเมาสอกครงเพอก าหนดเสนคขนานใหม
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 กลมเครองมอชวยเหลอทมความส าคญตอการสรางโมเดลโดยทวไป
 ชดของเครองมอทมความนาสนใจและเปนประโยชนตอการสรางโมเดลใหมความถกตองและแมนย ามากขนประกอบดวยเครองมอดงน
 Tape Measurement: ใชในการวดระยะหรอขนาดของวตถ อกทงยงสามารถใชในการอางองขนาดวตถเพอปรบเปลยนไดอกดวย
 Dimension: ใชในการใสเสนบอกระยะใหกบวตถตางๆมคณสมบตของการเปนตวบงชเชงสามมต
 Protractor: ใชในการวดอางองมมตางๆรวมถงปรบองศาของวตถใหถกตอง
 Text: ใชในการชบอกค าอธบายตางๆ มคณสมบตของการเปนตวบงชเชงสามมต นอกจากนยงใชในการบอกขนาดรวมพนผวตางๆไดอกดวย
 Axes: ใชส าหรบก าหนดแนวแกนเฉพาะกจใหกบวตถตางๆเพอใชในการอางองส าหรบการสรางวตถทแนวแกนไมอยในระบบทเปนมาตรฐาน
 3D Text: ใชส าหรบเขยนตวหนงสอทมลกษณะเหมอนวตถสามมตโดยทวไป
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 SketchUp Design Modeling ARCT 301 การขนรปโมเดลอาคารดวยเครองมอ Sketch Up แบบงายๆ
 เปาหมายของแบบฝกฝนน เปนการท าความเขาใจและใชเครองมอในการขนโมเดลอาคารแบบงายๆ
 1. ใชเครองมอสรางรปสเหลยม โดยก าหนดขนาด กวาง 5 เมตร ยาว 5 เมตร โดยการพมพ 5, 5 (ตวเลขจะแสดงท
 command input ดงแสดง) แลวกด Enter
 2. ใชเครองมอ Push/Pull ดงผวสเหลยมขนมาใหมความสง 5 เมตร โดยการลากเมาสในแนวทตองการแลวพมพ 5
 ตวเลขจะแสดงใน command input แลวกด Enter
 3. ใชเครองมอ Outline สรางเสนคขนาน ระยะเขามาดานใน 1 เมตร เลอกไปทผวดานบนแลวคลก ขยบเมาสเขามาดานใน จากนนพมพ 1 แลว Enter
 Command input
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 4. ใชเครองมอ push/pull ดงผวดานในขนมาดานบนอก 0.8 เมตร
 5. ใชเครองมอเขยนวงกลมภายในบรเวณดานบนทดงขนมา โดยการใช snap ของโปรแกรมเขาชวยอางองจด
 กงกลางดานบนและจดกงกลางดานขางจะมเสนแนวก ากบให แลววางวงกลม
 ทเขยนในสวนกงกลางของผดดานบน ขยายวงจนเตมขอบผวดานบน
 6. ใชเครองมอเขยนเสนเขยนใหเกด sector วงกลมในแนวตง sector ทสรางขนนตองเปนพนผวปดเทานน
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 7. ใชเครองมอ follow me คลกทผว sector แลวไลตามขอบวงกลมทสรางขนจนไดรปโดมดงกลาว
 8. ใชเครองมอเขยนเสนเขยนขนบนไดดานขางกลอง โดยใหลกตง 0.18 เมตร และ ลกนอน 0.25 เมตร
 จากนนท าการเลอกเสนทงลกตงและลกนอนโดยใชปม
 Shift ชวยเลอก
 9. ใชเครองมอ Move ขยบเสนขนบนไดทสรางขนโดยอางองจดปลายเสนลกตงดงกลาว แลวกดปม Ctrl key จะ
 เปนการคดลอกวตถ วางไวจดปลายลกนอนเสนแรก จากนนใหท าการเพมขนบนไดโดยการพมพ จ านวนขนทตองการ ในสตรดงน ?X (?: จ านวนทตองการเพม) ในทนใหใส 10x เนองจากตองการเพม 10
 ขน
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 จากนนท าการคดลอกขนสดทายขนไปอก 1 ขนแลวกลบดานโดยการคลกขวา แลวเลอก Flip Along > Green
 Direction จะไดขนบนไดทกลบเปนอกดานแลวเลอนในต าแหนงทถกตอง จากนน ใชค าสง Move แลวกดปม Ctrl หนงครง วางต าแหนงเสนบนไดขนเสตปอกครง แลวพมพ 10x เพอเพมจ านวนขนบนไดเชนเดม
 แลวท าการตอเตมเสนใหไดแนวทางในการดงพนผวดงกลาว
 10. ใชเครองมอ push/pull ดงผวโมเดลสวนแรกยนออกมา 1 เมตร
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 แลวดงสวนหลงยนออกมาจากแนวแรกอก 1 เมตร ดงแสดง
 จากนนดงกลองดานหนาโดยประมาณใหมขนาดเหมาะสมเพอท าเปนซมดานหนาอาคารดงแสดง
 11. ใชเครองมอในการเขยนเสน ปรบแตงซมประตใหมความโคง
 12. ใชเครองมอ outline ดงเสนขอบประต ตามขนาดทเหมาะสม
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 จากนนใชเครองมอ push/pull ดงขอบประตออกมาใหมความหนา 0.2 เมตร
 สดทายท าการลบผวประตดานในออกจะไดอาคารดงรป
 การสรางพนทส าหรบงานออกแบบโดยทวไป
 แบบฝกฝนนตองการใหนกศกษาสามารถน ารปภาพมาใชในงานและปรบขนาดทถกตองรวมถงการจดท าพนผวของพนทตามความเหมาะสมของเสนชนความสงจรง 1. ท าการน าเขาไฟลรปภาพโดยเลอก File > Import และเลอกรปภาพทเลอกมา โดยใหเชคเลอกไปท Use as Image
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 2. วางรปภาพในต าแหนงทตองการและขยบใหไดขนาดพอประมาณยงไมตองสนใจขนาดทได เชนเดยวกบการใชเครองมอเขยนสเหลยม
 3. ใชเครองมอเขยนเสน สรางเสนอางองทรปความยาว หรอขนาดทแนนอน เชน ความกวางถนน ความกวางแมน า ความ
 กวางอาคาร เปนตน ซงอาจจะตอง zoom in เขาไปใกลๆ เพอใหเขยนเสนอางองไดถกตองมากขน
 4. ใหใชเครองมอเทปวดระยะ ท าการวดระยะของเสนทสรางขนโดยคลกทจดแรกและจดสดทาย จากนนใหพมพตวเลขความกวางถนนนนลงไป (เมอวดระยะเสรจหามไปใชค าสงอนใดๆเดดขาด) คอ 16 เมตร

Page 19
                        

19
 พมพ 16 แลวกด Enter
 โปรแกรมจะถามวาจะปรบขนาดโมเดลใหตรงตามทคยหรอไม ใหเลอก Yes
 โมเดลจะท าการปรบขนาดใหม ซงตอนนมขนาดตรงตามความเปนจรงแลว จากนนใหคลกขวาทรปภาพทปรบขนาดแลวเลอก explode จะเปนการแยกกลมวตถใหเปนวตถซงแกไขไดใน
 สวนยอย
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 5. ใชเครองมอในการเขยน เขยนเสนขอบเขตโครงการและถนนออกมา โดยเขยนลงบนรปภาพทจ า
 การแยกกลมองคประกอบแลว
 6. ใชเครองมอ push/pull ดงผวแตละสวนขนมาใหมความแตกตางกนไป และใชเครองมอ Text ชไปทผวของผงโครงการแลววางลงณ ต าแหนงใดๆ จะไดขนาดพนทโดยรวมของโครงการนนออกมาเปน ตารางเมตร
 7.เปดไปทมมมอง top vies แลวใชเครองมอ เสนแบบ free line หรอแลวแตถนด เขยนเสนแบง เสนชนความสงในพนทโครงการออกมา โดยจะใชแนวเสนเดมทมชวยอางองและสมมตแนวใหมใหละเอยดขน
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 8. จากนนใชเครองมอ push/pull ดงผวแตละสวนใหมความสงต าตามเหมาะสม ซงหากเปนแผนทจรงเมอทราบความสงแตละระดบใหใชการคยความสงใสลงไป
 จากนนเปดเครองมอ sandbox
 tool ออกมา โดยไปท window > Preferences > Extensions > Sandbox Tools
 จะไดชด
 เครองมอดงกลาว ซงใชในการจดการกบแนวเสนระดบ พนทตางๆ รวมถงท าพนผวทมการลกษณะเปน fabric
 9. เลอกพนผวของโครงการทดงขนมาเปนชนๆแลวทงหมด อาจจะใชวธลากคลมกได
 จากนนเลอกไปท เครองมอ From Contour
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 จะไดพนผวทมการค านวณตามความสง contour ดงกลาว
 เลอกไปยงพนผวทไดใหมและขยบออกมาจะเหนผลลพธ
 การใสลวดลายและก าหนดวสดใหกบโมเดลทางสถาปตยกรรม
 แบบฝกฝนนตองการใหนกศกษาเขาใจและควบคมการน ารปภาพหรอสสน มาใชเปนลวดลายส าหรบศกษาโมเดลในชนตนไดเพอแสดงออกซงแนวคดไดอยางเหมาะสม
 1. เปดไฟลทเตรยมไว ex 004.skp
 จะไดโมเดลอาคารดงแสดง
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 จากโมเดลดงกลาวจะตองน ารปลายภาพเขยนจตรกรรมมาแปะในสวนดานผนงดานสนโดยใหมสดสวนทเหมาะสม โดยการน าเขารปภาพทถายไว File
 > Import แลวเลอกรปภาพ 1216776342.jpg และใหเลอกแบบ Use as texture
 2. วางรปทไดลงบนผนงทตองการ ลากขนาดใหเตมจนชนขอบดานบนแลวจงวางรปภาพ รปภาพทไดจะเกดขนเปนลวดลายของผนงดงกลาว
 แตลวดลายทไดยงคงมความผดเพยนทงในเรองของมมมองและรปสวนเกนดงนนจงตองท าการตดและปรบแตงดงน
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 3. จากรปดงกลาว คลกขวาทผนง แลวเลอก Texture > Position
 จะมหมดโดยรอบรป 4 หมดซงใชในการอางองและก าหนดมมมองของภาพ นอกจากนเมอกดปม Shift หมดดงกลาวจะแสดงคณสมบตการปรบเปลยน ขนาด ความเอยง และการบดตวของ ลวดลายไดอกดวย
 4. ใหท าการขยบหมดทงสโดยการคลกทหมดครงเดยว วางไวในต าแหนงของภาพทตองการจะใหแสดงบนผนงนน จากนนคลกคางทตวหมดแตละจดจบเลอนมาชนแนวขอบผนงแตละมม ซงอาจจะดความเอยงของภาพประกอบหากยงไมไดใหท า
 การเลอนหมดแลวลากวางใหม
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 เมอไดรปในลกษณะของต าแหนงและขนาด ความเอยงภาพท
 เหมาะสมแลวใหคลกขวา แลวเลอก Done จะจบกระบวนการในการปรบแตงใหไดภาพทตองการบนผนงดานนน
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 5. นอกจากนยงสามารถใสลวดลายในลกษณะของการแสดงแนวคดโมเดลไดโดยใชเครองมอ paint แลวเลอก
 ลวดลายทตองการและเหมาะสม จากนนน าเมาสทเปนรปถงเทสคลกลงไปยงพนผวท
 ตองการ โดยสามารถท าการหรบโทนสของพนผว หรอขนาดของลวดลายนนไดทหนาตางเครองมอ Material ในสวนของการ Edit ดงแสดง
 ใหทดลองท าการใสลวดลายลงบนโมเดลใหสมบรณ จะไดใกลเคยงดงภาพ
 โทนส
 ขนาดลวดลาย
 ความโปรงใส
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 การสรางโมเดลจากรปถายหรอรปสเกตซ
 แบบฝกฝนนตองการใหนกศกษาเขาใจกระบวนการในการน าภาพทรางหรอรปถายอาคารมาทาบเพอใชในการขนแบบโมเดลอยางรวดเรว
 1. เมอไดแบบรางดงภาพทแสดงจะเปนจดเรมในการขนแบบโมเดลทตองการ ท าการน ารปแบบรางทไดเขาสโปรแกรม File > Import แลวเลอกไปทรป building-sketch1.jpg โดยเลอกแบบ Use as New Matched Photo
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 2. หนาจอการท างานจะเปลยนเขาสโหมดการตงคา Matched Photo ดงภาพ โดยจะมแนวเสนและมมมองภาพทตองปรบเหมอนการยงแนวเสนเขยน ภาพ perspective แบบ 2 จด
 โดยท เสนสน าเงนเปนแนวแกนตง หรอแกน Z
 เสนสแดงเปนแนวมมมองดานซาย หรอแนวแกน Y
 เสนสเขยนเปนแนวมมมองดานขวา หรอแนวแกน X
 โมเดล ลงแซม จะใชเปนขนาดอางองเมอเทยบกบเสกลของรปอาคารทน ามาซอนทบ
 เสนกรด ใชในการอางองเวลาขนโมเดลตางๆ
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 3. คลกคางเลอนเสนสน าเงนใหตรงแนวแกนตงโดยปกตจะใชมมอาคารอางอง และใช ลงแซมเทยบเสกลอาคาร โดยเลอนเมาสขนลงตามแนวแกนสน าเงนจะเปนการก าหนดขนาดอาคารดงกลาว
 4. คลกทจดแกนสแดงและสเขยวใหเปนมมมองในแนวราบโดยมากจะอางองจากเสนขอบอาคารทราง หรอถายรปมา โดยเสนขอบอาคารนน ไมจ าเปนตองพาดเปนแนวเดยวกนส าหรบแกนสแดงและสเขยว
 5. เมอปรบแกนแนวราบจนไดมมมองทเหมาะสมแลวมาปรบขนาดการแสดงของเสนกรด ทจะใชชวยอางองในการขนโมเดลโดยอาจจะก าหนดท 1 เมตรเพอใชอางอง แลวกด Done
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 6.ใชเครองมอเขยนเสนสรางฐานอาคารและขนรป โมเดลอาคารตามปกต
 โดยอาจจะใชการสลบมมมองอนๆเขามาชวยใหจดการกบวตถไดงายขน โดยเฉพาะ Top view จะชวยใหเลอกวตถไดงายขน
 ซงเมอเลอกวตถในมมมอง Top view หรอมมมองอนๆแลวสามารถกลบมายงมมมองของ Photo
 Matched ไดโดยการคลกทแถบหนาตางดานบนมมซาย จะเปนการหมนกลบมายงมมมองเดม
 ขนรปอาคารโดยใชเครองมอ Edit Tool เขามาจดการใหเหมาะสม
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 7. ส าหรบค าสงสเกลตองใชส าหรบการท าใหทรงอาคารบานออกโดยเฉพาะดานบน ซงมวธการทงายเมอเลอกพนผวจาก
 Top view แลวใชปม Ctrl key จะท าใหจดอางองของการปรบขนาดมาจากจดกงกลางแผนโมเดลนน
 ขนรปโมเดลจนถงชนดาดฟา ซงตองท าแนวหลงคาโคง
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 8. ใชเครองมอเขยนเสนปกตในการเขยนหนาตดแนวหลงคาโคง โดยอาจจะสรางแนวกงกลางหลงคามากอน
 แลวใชเทปวดชวย
 สรางแนวอางอง โดยเลอกเครองมอแลวคลกไปยงแนวเสนขอบทตองการอางอง ในทนอาจจะเปนขอบดานในราวกนตกชนดาดฟา แลวขยบเทปวดออกมาจะมเสนประเปนแนววด
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 ใหพมพ 1 แลวกด Enter
 จะไดแนวอางองสมมตออกมาโดยมระยะหางจากขอบดานในราวกนตก 1 เมตร (สามารถใชวธนอางองการสรางแนวในการท างานตางๆได)
 สรางแนวอางองตางๆทเหมาะสมเพอใชในการเขยนหนาตด
 หลงคาโคง

Page 34
                        

34
 9. สรางหนาตดหลงคา ขนมา
 แลวใชเครองมอสเกลชวย
 ปรบขนาดใหเหมาะสม แลวจงใชเครองมอ
 push/pull ชวยดงอาคารใหไดขนาด โดยอาจจะใชมมมอง Top View ชวยในการก าหนดระยะ
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 ทายสดจะไดอาคารในลกษณะใกลเคยงดงกลาว 10.ท าการ ปะรปทใชอางองลงบนโมเดลดงกลาว โดยการเลอกไปท Window > Match Photo
 แลวกดเลอก Project textures from photo
 และเอาเชค หนา Photo ออก จะเปนการน ารปภาพทเปน Back Ground ออกไป ซงจะไดรปดงกลาวออกมา
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